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Members’ Night Image Submissions – Submit your images between October 10th and Noon on the 
14th for the final Members’ Night of the year!  Once again you get the benefit of a critique and live edit 
suggestions. 

CREEC Photo Contest – Dave Ficke is looking to form a committee for the California Regional 
Environmental Education Community Network (CREEC) Region 10 Environmental Photo Contest, 
Sponsored by the Redlands Camera Club.  This is a great opportunity to help run a great contest for 
a great cause, and help some fledgling photographers as well.  If you are interested, see the flyer 
attached to the Photogram e-mail this month or contact Dave at yosemitedave1@hotmail.com.  

Aquarium of the Pacific - The Aquarium of the Pacific in Long Beach is sponsoring its 8th popular 
annual photographers’ night on October 9. Tripods and other photographic equipment not normally 
permitted at the aquarium are allowed for this event. Cost is $29.95 ($26.95 for members). See the 
Aquarium of the Pacific website for details. 
http://www.aquariumofpacific.org/events/info/photographers_night/ 
 
ColorMunki – Contact Lois Ritchie-Ritter at loisritchie@yahoo.com to reserve the ColorMunki. 

Photogram – If you have photo equipment that you are looking to sell, why not let club members 
know.  Send your submissions to carl.oday.rcc@gmail.com by the third Thursday of the month to be 
included in the following Photogram. 

Programs for October & November 2016 

 

Details for the current month’s programs may be found in the Programs article, starting page 4.

  

October 3rd October 17th November 7th November 21st 

Minimalist 
Photography 

 

With Tom 
Windeknecht 

Members’  
Night 

 
 

With Live Edit 
 

Great Pirate 
Portraits 

 
RCC Shooters Show 

us How! 

Photographing 
Desert Wildlife 

 
 

With David Jesse 
McChesney 

PHOTOGRAM 
Monthly Newsletter of the Redlands Camera Club 

October 2016 

Redlands Camera Club meets:  1st & 3rd Mondays, 7:00 pm 
First Presbyterian Church - 100 Cajon St - Redlands, CA 

Guests are always welcome 
 

© Redlands Camera Club & Contributors  The contents of the Photogram are copyrighted.  No material herein may be reproduced in any  
Manner without the written permission of either the Editor or the material’s specific contributor. 

 

mailto:yosemitedave1@hotmail.com
http://www.aquariumofpacific.org/events/info/photographers_night/
mailto:loisritchie@yahoo.com
mailto:carl.oday.rcc@gmail.com
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Carl Detrow 
 

      
 
 

RCC Bids Happy Shooting to Jerry Reece 
 

Last month we bid farewell to Jerry Reece who leaves us to join his daughter in Texas. We honored 
him and Bessie with the President’s Award for Exceptional Service on September 19. The following is 
the citation that accompanied the award.  
 
Happy Shooting, Jerry. 
 
 
 

Citation to accompany the presentation of the President’s Award for Exceptional Service 
To 

Jerry and Bessie Reece 
 

Jerry and Bessie Reece distinguished themselves as members of the Redlands Camera Club since 
early in the 21st century. After a career in teaching and school administration, Jerry joined the club in 
around 2002, and Bessie about a year later. Though Bessie left us unexpectedly last year, we fondly 
remember both as members of a team of fine photographers.  

Bessie was active in a variety of community activities, and also served as our membership chair. She 
entered nearly every competition and took home more than one Best of Show ribbons. She was one 
of the finest photographers many of us have ever known. 

Jerry served the club in a number of capacities including President and Photogram editor. He has 
also served as a reviewer on members’ night panels, and also has presented programs on 
composition and abstract photography. He has been the club’s leading authority on Nikon and, more 
recently, Fuji gear. He has submitted many fine images to competitions and won best in category in a 
number of competitions. He has been a close second to another photographer (who shall remain 
nameless) on several occasions, and has loved every minute of it.  

Jerry will be leaving Southern California soon for the somewhat more humid skies of Texas. It is with 
sadness that we bid goodbye, but with great pride that we present the Redlands Camera Club 
President’s Award for Exceptional Service to the team of Jerry and Bessie Reece. As a token of our 
appreciation, Jerry is also extended a life membership to the Redlands Camera Club. 

 
Given this day, September 19, 2016, 

 
 
 

Carl S. Detrow 
President, Redlands Camera Club 
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Jim Hendon 

 

October 3
rd

 – Simple is Beautiful: Minimalist Photography  

With Tom Windeknecht 

 

Join Redlands shooter Tom Windeknecht for a program on 
"minimalism" in photography, which emphasizes extreme simplicity in 
subjects and composition. Tom's a self-taught Canon shooter who also 
fires away at the wide world with his Android phone. He captures 
compelling, simple images while networking on Instagram with 
hundreds of fellow minimalists in a 24/7 online camera club. Inspired by 
nature, architecture, lines and shadows -- and emphasizing clean, 
minimal compositions with bright colors -- Tom seeks to provoke an 
emotional response and provide a unique visual experience. He'll tell us 
about it, share his work plus images from others, and talk about his web 
site and the Instagram experience. Many of us have experimented with 

minimalism. Here's a simplicity specialist to show us what's possible and cheer us on! 
 

October 17
th

 – Final Members Night of 2016: 

Submit 2 Images 
Did you shoot some prize winners during summer? Share your images 
at our Oct. 17 Members Night and get some tips to prepare them for the 
club’s Winter Competition in December! At Redlands Camera Club, we 
aim to “Make You a Better Photographer,” and Members Nights are our 
primary forum for review and feedback. For this meeting, our reviewers 
will comment on your shots on screen. Also, a Live Editor will select five 
to demonstrate on screen how they might be improved using 

Lightroom. Submit your images via the RCC web site between Monday Oct. 10 and noon, Friday, 
Oct. 14. Our scheduled reviewers are Alex Woodcock, Dave Ficke and Jim Hendon, with Live Editor 
Bruce Woodcock  
 

November 7
th

 – Pirate Portraits? RCC Shooters Show us How! 
Shiver me timbers! After a cool field trip to the Tall Ships last month, the 
Redlands Camera Club BLOG became an overnight showcase for 
pirate portraits! Now five RCC shooters have agreed to show us -- step 
by step -- how they made these striking images of the beloved, bearded 
scalawags of the high seas. Each one is different in composition, 
lighting, tone and creative treatment -- buried treasure for RCC 
members. And behind each shot are tips and ideas for making photos 
of colorful and historic characters into photographic fine art. Our 

scheduled presenters are Debra Dorothy, Judith Sparhawk, Stephanie Billings, Mary Ann Ponder and 
Deb Seibly. See you there, matey!   
 

November 21
st

 – Photographing Desert Wildlife  
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With David Jesse McChesney 

  
John Williams

 

 

Now is the time to renew your Membership for FY 2016-2017! 
 

Membership Renewal – Thanks to all of you who have renewed your RCC membership.  It's not too 
late to renew your Membership.  $25 is a great deal for all of the benefits that Redlands Camera Club 
offers.  Only currently paid members can take part in education classes, competitions, events, free 
workshops, and field trips.  Dues are the primary source of club revenue allowing us to provide you 
with quality programs and training.  Contact John Williams at jhwr@earthlink.net if you have any 
questions about your membership renewal. 

Prospective new members please note:  At Redlands Camera Club you’ll find a group of photo-
enthusiasts with a wide range of interests, a ton of experience and a willingness to share.  Our 
regular club meetings offer stimulating programs, members’ nights and competitions; in addition, we 
offer field trips, workshops, classes and opportunities for mentoring.  You can obtain an application 
form at one of our regular meetings or from our website by going to the club web site 
(www.redlandscameraclub.org), clicking on the “Downloads” tab and then clicking on “Membership 
Application” tab.  Follow the instructions on the form and your all set! 

All members please introduce yourself to our newest members and help direct them to members who 
can assist them become a better photographer.  We try to get a brief Bio from each of our new 
members.  Contact me by email (jhwr@earthlink.net) if your Bio has not appeared and you wish to 
have it included in the Photogram. 

A big welcome goes to the following newest members: 

Richard George 

Owen Owens 

Steve Rich 

  
Rick Strobaugh

 

 
 

 

I will be doing another pre-meeting mentoring session at 5:30 PM prior to our regular meeting on 
October 17. Anyone interested in attending, please contact me at rpdrunner@msn.com for subjects 
that you would want to be discussed. This way, I can cover subjects that you are interested in or want 
to learn more about. That makes it more productive than me trying to guess what people may want 
covered. We will meet at the regular meeting location and if you are coming from work or anything 
else where you need to eat something, feel free to bring some food with you. 

mailto:jhwr@earthlink.net
http://www.redlandscameraclub.org/
mailto:jhwr@earthlink.net
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Debra Dorothy  

             
 

San Manuel Pow Wow 

 

Date:  Saturday October 9th 

Location:  Cal State San Bernardino: 5500 University 
Parkway, San Bernardino, CA 

Price: Free 

Parking Location: Public parking is free in lots G and H on 
Kendall Drive 

We will meet at the Coco's Bakery Restaurant 1140 W 
Colton Ave, Redlands, CA 92374 at 9:00AM. 

All weekend activities will take place on the university’s soccer fields near the Coussoulis Arena. 

For those carpooling plan to be there most of the day. They do they're grand entry at 1:00 P.M. And 
8:00 P.M. 

You can find more information of this event from they're website at: https://www.sanmanuel-
nsn.gov/Culture/Pow-Wow 

Hope to see you there! 

If you have any questions you can call me at 909 633-2913 or email me at 
Debbiedsd.dorothy@gmail.com 

 

  
Russ Trozera 
 

 

2016 Winter Competition 

 

The golden time of year is upon us.  Leaves will start falling. Turning yellow, orange and reds. What a 
wonderful time of year.  Just as Fall is upon us so is the Redlands Camera club competition.  Now is 
the time to get your images ready for the competition.  Uploading begins Monday November 7th and 
ends at 11 PM November 21st. The Competition will be on December 5th and ribbons will be 
awarded on December 19th Please remember that you can upload 3 images for this competition. 
Please see our tutorials and rules for submitting images. If you have any questions please call me 
(760) 486 5269. My new e-mail is photosbuyruss@yahoo.com. I home everyone had a wonderful 
summer. 

 

If you have any questions, please email Russ at: photosbuyruss@yahoo.com 

https://www.sanmanuel-nsn.gov/Culture/Pow-Wow
https://www.sanmanuel-nsn.gov/Culture/Pow-Wow
mailto:Debbiedsd.dorothy@gmail.com
photosbuyruss@yahoo.com
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Wayne (Woody) Wood 

 

Bruce Woodcock 

I am a native So Cal country boy. My childhood was spent in what is 
now Westminster, California. From the tree in my backyard I could 
see the ocean only 8 miles away - only farm land separating me 
from the beach. My summers were spent getting up early and riding 
my bike to the beach - surfing, skim boarding, fishing, skin diving. 

I served two years in the Army from 1966-68. Got lucky and was 
sent to Korea instead of 'Nam for 13 months. The G.I. Bill put me 
through college (10 long years of night school). I finally received my 
B.A. in Business Administration from California State University, 
Fullerton in 1978. After 34 years working for GTE before it became 
Verizon, I retired in 1999. 

It wasn't until I married my wife Sandy in 1981 that I became 
interested in photography, with the help of a second hand Nikon F2. 
That's how I learned to use a fully manual camera. That and taking 
a few classes and a lot of notes about each slide. Now I shoot with a 

Nikon D90 which I bought shortly after I joined the Redlands Camera Club a little over a year ago. 

I enjoy taking photos of land/seascapes, animals, nature, close-ups, and places. I find the most 
creative satisfaction in taking two average images and making a better one (ex. The 49 Ford Woody). 
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Judith Sparhawk 

Kent Fogleman Featured Artist at RAA 
RCC member Kent Fogleman is currently the Featured Artist at Redlands Art Association, showing 
through October 7th.  His show features an eclectic selection of his photographs, including travel 
images, animals, and Western themes.  Stop by and take a look at RAA’s gallery at 215 East State 
Street in downtown Redlands.  Hours are 11 am to 4:30 pm, Monday through Saturday. 
 
 

RCC Show at First Methodist Church 
For the third year in a row, RCC has been invited to present a photography show of some of our best 
work.  Nine of our photographers are represented in the show, presenting a wide variety of subjects, 
including landscapes, people, birds, and flowers, among other things.  The show is now hanging in 
the gathering room at the church, at 1 East Olive Avenue in Redlands. 

A reception will be held on Sunday, November 13th, from 2:00 to 4:00 pm.  Here is your chance as 
RCC members, to come and celebrate the club’s beautiful work, to bring family and friends, enjoy 
refreshments, and socialize with club members. Don’t forget to mark your calendars for a fun 
afternoon and a feast for the eyes. 

  
Carl O’Day 
 

 

 

53 users and 391 images later the RCC Photo Blog is still going strong.  If you 

do not already have an account, send an e-mail to signup@rccphotoblog.com 

and we will get you set up.   

The blog is a great place to get input on your images – particularly with a 

competition coming up.  Other Members’ images can help you find some 

inspiration (and perhaps some motivation). 

Sign up today! 

mailto:signup@rccphotoblog.com
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2016 Summer Competition – 2
nd 

Place 
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2016 Summer Competition – 3
rd

 Place 
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Club Calendar   

             Information that was available to the editor at the time of publication.  
 

October 3 Minimalist Photography with Tom Windeknecht 

October 8 Field Trip: San Manuel Pow Wow at Cal State San Bernardino 

October 9 Aquarium of the Pacific Photographer’s Night 

October 17 Members’ Night 

November 7 Pirate Portraits with RCC members Debra Dorothy, Judith 
Sparhawk, Stephanie Billings, Mary Ann Ponder and Deb Seibly 

November 21 Photographing Desert Wildlife with David Jesse McChesney 

December 5 RCC Winter Competition 

December 19 Competition Awards 
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(Note:  The views expressed in this article are those of the author and do not  

necessarily reflect the views of the Photogram or of Redlands Camera Club.) 

By John Williams 

New features in Adobe Photoshop 2015.5 

Content-Aware Crop: 

 Content aware technology will intelligently fill in the gaps when you use the Crop tool for rotating 
or straightening an image, or expanding your canvas beyond the image's original size.  To 
enable check the Content-Aware box. 

 

 Content-Aware fill on Crop is not supported in the Classic mode of the 
Crop tool.  To disable the Classic mode, do the following: 

1. With the Crop tool selected, click the Gear icon in the toolbar. 

2. In the settings menu that appears, deselect Use Classic Mode. 
 
Glyphs panel: 

 You use the Glyphs panel to insert punctuation, superscript & subscript characters, currency 
symbols, numbers, specialized characters, as well as glyphs from other languages into text in 
Photoshop. 

 To access the panel, select Type > Panels > Glyphs or Window>Glyphs. 

 
A. Most-recently-used glyphs | B. Set font family | C. Set font style | D. Set font category | E. 

Glyph slots | 
F. Zoom out | G. Zoom slider | H. Zoom in | I. Scale down glyphs | J. Scale up glyphs 

 Working with Glyphs panel:  To enter a glyph in an active text layer, do the following: 

1. Use the Text tool to place an insertion point where you want to place the glyph. 

2. Double-click a glyph in the Glyphs panel. 
For each font, the glyphs are organized into different categories, such as Basic Latin, Latin 
A, Latin B, Numbers, Currencies, Symbols, etc. 



~ 13 ~ 
 

Glyphs are also organized by the OpenType features that the font supports, such as 
Alternates, Ornaments, Swash, Numerators, Denominators, Stylish Sets, Tabular Figures, 
Ordinals, etc. 

On-canvas glyph alternatives: 

 If your font is an Open Type font that includes an 
expanded character set (Adobe Type Library having 
an [.otf] suffix in the font file name), then this feature 
allows you access to hidden swashes, and super 
elegant typography.  Many fonts with the word 'pro' in 
their description will have alternative glyphs.  You can 
highlight a single letter with your Type tool (red arrow) 
and a popup dialog will appear to give you alternatives 
glyphs right on the canvas.  Click on an alternative 
glyph to replace the font character.  Clicking the arrow 
at the bottom of the alternative glyphs grid will open 
the Glyphs panel. 

 For this feature to work, go to Preferences>Type and check the Enable Type layer glyph 
alternates box. 

Determine a font from a flattened image: 

 Place a tight selection (Rectangular Marquee Tool) around the font you are trying to identify. 

 Choose Type>Match Font.  The following dialog box will open giving you choices of the match 
Photoshop has determined. 

 

 This feature is not always accurate identifying fonts.  However, the suggestions are generally 
close.  The correct font identification in my trial effort was 'Brush Script Std Medium' (listed under 
Fonts available under Typekit). 

 If you click on icon in front of the Typekit font name (red square above), it will automatically load 
in your font directory (make sure Show fonts available to sync from Typekit is enabled as 
indicated by red arrow above). 
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Redlands Camera Club    P.O. Box 7261 Redlands, CA 92375 

www.RedlandsCameraClub.com 

Officers (2016-2017) 

President:  Carl Detrow     Vice President/Programs:  Jim Hendon     Secretary:  Judith Sparhawk    

Treasurer:  Joe Ligori      Past President:  Steve Oberholtzer      Member-at-Large: Jerry Reece 

Chairs (2016-2017) 

Color Munki:  Beverly Brett      Competition:  Russ Trozera     Education/Workshops:  Frank Peele    

Facebook/Event Photographer:  Bruce Woodcock        Field Trips:  Debra Dorothy      

Historian:  Bruce Bonnett       Hospitality/Events:  Lucy McGee      Librarian:  Mary Ann Ponder      

Membership:  John Williams       Mentor:  Rick Strobaugh     Photogram: Carl O’Day       

Publicity: Alex Woodcock         S4C:  Deborah Seibly      

Webmaster: Wayne (Woody) Wood       Welcome:  Stephanie Billings 
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